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Q There are a bunch of files with .PMG extensions in
my publication folders. What are they?

A Those PMG files are what the “PS Group it” Addition cre-
ates when you group elements in PageMaker. To group ob-
jects, “PS Group it” creates an EPS graphic of the selected el-
ements, and saves it with the file extension .PMG in the
same directory or folder as the publication. Then it imports
the graphic exactly where the objects were originally.

As long as the grouped object or any copies of it are
present in your publication, it’s a good idea not to delete or
move the PMG file, since PageMaker needs it both to un-
group the object(s)-and to print at high resolution to a
PostScript device. Here's why. g

A PMG file is an EPS graphic that contains both a low-
resolution, bitmap version of the image for display on
screen (the screen image is also used for printing to non-
PostScript devices) and the PostScript information needed
to print at high resolution to a PostScript printer. When “PS
Group it” creates the PMG file, PageMaker always imports
the PMG file with the “Store inside publication” link option
turned off, so only the low-resolution screen image is stored
inside the publication.

Therefore, when you print “PS Group it" objects, Page-
Maker must have access to the external, linked PMG file to
be able to download the high-resolution graphic data to a
PostScript printer. If you delete, move, or rename the PMG
file, PageMaker won't be able to do this and will print only

Magazine. If you have a question about the products listed here, please see the
phone-support options listed on pages 102 and 103 of this issue.

We're always looking for good tips. Send us your favorite, and if we print it we'll send
you an Adobe Magazine sweatshirt. Send your tips to Editor, Adobe Magazine, 411
First Avenue South, Seattle, WA 98104-2871. Please include your name and phone
number in case we need more information.
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the low-resolution, bitmap screen im-
age. You can change this on a file-by-
file basis through the “Links” dialog
box (choose “Links...” from the File
menu, select the file, click “Options...,"
and check “Store copy in publication”).

Another reason you shouldn’t de-
lete PMG files is that they contain in-
formation “PS Ungroup it" needs to
ungroup your object. This means that
if you delete a PMG file for a grouped
object, you won't be able to ungroup
the object or any copies of it. When
you do ungroup a grouped object, you
can choose to have “PS Ungroup it”
automatically delete the PMG file. Re-
member—if you decide to do this, you
won't be able to ungroup any copies
of the grouped object that you may
have made.

The “PS Ungroup it” dialog box also
asks if you want to always delete PMG
files when ungrouping, and includes
the option of never displaying the “PS
Ungroup it” dialog box again. If you
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PS Ungroup it

select this option and later decide you want to view the dia-
log box while ungrouping, quit PageMaker and then delete
the preference file that contains this setting. On the PC, de-
lete the UNGROUP.PRF file in the ALDUS\USENGLSH\ADDI-
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TIONS directory; on the Mac, delete the “PS Group it prefer-  and select a color from the Colors palette.
ences” file, located in the System:Aldus:Additions folder. To set a default color for both lines and fills, make sure no
objects are selected, click on any tool other than the text
tool, make sure “Both” is selected in the Colors palette drop-
down menu, and select a color from the palette. If you want
to have different default colors for fills and lines, the easiest
way to set them is to make sure no objects are selected, -
choose “Fill and line..." from the Element menu, and select
your new default colors in the “Fill and line” dialog box.
A If you want all new text blocks in your publication to use You can also set application-wide defaults, which will af-
a particular font, what you're after is a new default font: fect all new publications you create thereafter. To do so,
make sure you have no text selected (a good way is to click close all your publications and then change any settings

on a tool in the toolbox) and select the font you want. that aren't grayed out. PageMaker stores these application-
In fact, to change any default—text or other settings— wide defaults in a configuration file (PM5.CNF, located in the

make sure you have nothing selected and then changeyour ~ALDUS\USENGLSH directory in Windows, or the “PMS5.0 De-
settings. The new default will affect any new stories you cre- faults” file located in the Preferences folder within the Sys-
ate, new objects you draw, or new graphics you import. tem Folder on the Macintosh). If you ever want to restore
The only exception to this rule is with color. You can have ~ PageMaker’s original application-wide defaults, quit Page-
three default color settings—a default color for text, a de- Maker and delete or rename its configuration file—it will
fault color for lines, and a default color for fills (which also  2utorhatically generate a new one the next time you re-
functions as the default color for 1-bit and grayscale bitmap  launch PageMaker and create or open a publication.

graphics). To set a default text color, click on the text tool

Q Sometimes when | change the font in a publication,
it reverts to a different font when | begin a new text
block. How do you make sure the font is permanently
changed for the publication?

Q Sometimes | check my “Links” dialog box and see

a8 —\ unusual characters in front of my linked document or
Page Maker PC letters for page numbers. What does this stuff mean?
A The symbols

Different colors for margin, column, and ruler guides that appear to ":_m = WE
By default, PageMaker’s ruler guides are cyan, column guides are light blue, margin t‘he - ‘your Rodhody o B -
guides are pink, and the “floor” (the area that surrounds the pasteboard) is light A ObJec.ts £ Y a:':.«.. Equation
yellow. Sometimes these colors aren't very practical—for instance, if you're working .convey spe'clal s seact e g;f:s'
with a’lot of blue objects, you might not be able to see your column and ruler guides talarmasian o w1 4 =moeadincnidin
easily. By editing the ALDUS.INI file, you can customize the colors of these elements. - the.smus b - ; =3

To do so, make a backup copy of your ALDUS.INI file, which is located in the A e =T
ALDUS\USENGLSH directory, then open it in a text editor such as the Windows Oy S by A o e :,:i“[_‘__ ~
Notepad. The colors of these elements are specified as combinations of red, gnen; Yo U SPNGE KR 1y ;oL
and blue components, each of which is defined numerically as a value from 0 to 255. c_jeteds that SAR ¥ 2w s e e ~
When you open your ALDUS.INI file, you can enter the following lines in the e S
[PageMaker 5] section: : up to date. The characters e e e e e

that appear in the “Page”
ColumnGuideRGB=128 128 255 column to the right of your linked objects describe the ob-
jects’ page numbers or other positions.

If you're ever unsure what one of the link-status symbols
MarginGuideRGB=255 128 255 means, just click on the linked object displayed with the
FloorRGB=255 255 128 symbol and PageMaker will list an explanation of that
object’s link status in the “Links” dialog box under “Status.”

RulerGuideRGB=0 255 255

The numbers above are the default settings. The first number in each line is the

red setting, the second is the green setting, and the third is for blue. You can experi- Link-status symbols

ment with different number combinations to turn your guides and the fioor differ- NA Indicates the object is not linked to an external docu-

ent colors. For example, a setting of 192 0 192 equals purple, a setting of 192 192 fhiavit bachuse e GRJSE W RSt Wishout links or

192 is light gray, and a setting of 255 128 128 is pinkish orange. Restart PageMaker & M OLE ealied Rigpas.

for your changes to take effect. ? Indicates that PageMaker can no longer find the
Please note that some light colors may not display on a black-and-white screen. linked object’s external file—usually because that

Also, changing these settings in your ALDUS.INI file may not affect display color with file was renamed, deleted, or moved. Unless your ex-

certain high-resolution video cards, some of which display the guides as black re- ternal file has been deleted, you can re-establish the

gardless of what the ALDUS.INI settings are. link by clicking on the “Info..." button, locating the

- {iat 5 external file, and clicking “Link.”
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+ (PC) or ® (Mac)

Indicates that the object is linked to an external file
that has been modified since the link was first estab-
lished or last updated. Also indicates that you have
set that object to update automatically. Therefore,
PageMaker will update the object the next time you
print or reopen your publication. If you want to up-
date your object sooner, select it and click the “Up-
date” or “Update all” button in the “Links” dialog box.
Note: In Windows, the “+” also indicates that the object
is stored inside the publication.

X (PC only)

This is identical to the “+" symbol, except it indicates
the object is not stored inside the publication.

= (PC) or © (Mac)

Similar to the “#” or “+” symbol—indicates that the
object is linked to an external file that has been
modified since the object was imported or last up-
dated. However, unlike the “#” or “+” symbols, the
“o" or- “-" symbols indicate that you have not set the
object to update automatically. To update the object,
select it and click on “Update” or “Update all.”

1(PC) or A (Mac)

Page/location symbols

UN

LM
RM
PB
ov

Indicates that the object is linked to an external file
and that both the internal and external copies of the
object have been modified. If you click on “Update,”
PageMaker will replace the internal copy of the ob-

Q&APageMaker

Q I've noticed that my bitmap graphics tend to
appear very choppy in PageMaker, even with a high-
resolution video card installed. Is there anything | can
do to make them appear crisper?

A Yes. In fact, PageMaker has several features that let you
control how smooth your bitmap graphics look on screen—
you should just be aware that the smoother your bitmap
graphics appear, the longer they’ll take to redraw.

Before we list all your
options, here’s a brief over-
view of how PageMaker
handles bitmap graphic :
display. PageMaker gives
you three display choices
for your bitmap graphics.
These options, which are lo-
cated in the “Preferences”
dialog box, are “Gray out,”
“Normal” (the default), and

“High resolution.”

If you choose “Gray out,” your screen will redraw at the
greatest speed possible, but all your graphics (including
vector-based ones) will display as gray boxes. In addition,
some grayed-out graphics may not print to non-PostScript
devices. If you select “High resolution,” PageMaker displays
your graphics at the highest resolution possible, using all

ject with the external copy.
Indicates the link was established on an-

other platform (Macintosh or Windows),
and the object’s format isn’t completely
supported on your current platform (for
example, if you chose not to convert
metafiles to PICTs, or vice versa, when
you opened the publication).

(Unlike the other link-status symbols, this
symbol appears in the far right column of
the “Links” dialog box.) Indicates the ob-
ject will not print in high resolution or
may not print as expected—for example,
because a linked file is missing, a re-
quired filter is not available, or the linked
file has been modified since it was placed
or last updated.

Object is an inline graphic or text in a
story that has not been placed in layout
view yet (is part of an unflowed, un-
composed story in the Story Editor).
Object is located on the left master page.
Object is on the right master page.
Object is located on the pasteboard.
Object is an inline graphic located in
overset text—text that is not displayed in
layout view because it has not been com-

You think she’s fnishing the
roposal. She thinks you are.

And 1t’s 4 hours before the grant

committee meets. Let’s see, 16

new pages
11 am?(ﬁe TEVIEWS,
3,600 words sent
by your partners in
Istanbul. Who

can

Aaargh!

rise, neither one of you are.

of data,

faster?

pletely flowed.

Reader Service Card No. 32
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the data in the graphic files. The trade-off you make is per-
formance—when you use the “High resolution” option, your
screen redraw will be slower.

The “Normal” option offers a middle ground between the
other two options. When the “Normal” option is selected,
PageMaker displays your bitmap graphics using their low-
resolution screen images. With the “Normal” setting, your
bitmap graphics will redraw pretty quickly but won't look
very crisp. Just how chunky they look will depend on the
resolution of the screen image PageMaker created when
you imported the graphic, and that depends on the “Maxi-
mum size of internal graphic” setting in the “Other prefer-
ences” dialog box. By default, this option is set at 64K, and
you can change it to anything between 8K and 1024K. The
smaller you make this setting, the chunkier your screen im-
ages will look in “Normal” graphics mode, and the faster
they’ll redraw. If you alter this setting, the change will only
affect graphics you import or update thereafter.

If you have one or a few bitmap graphics that are display-
ing very poorly in “High resolution” or “Normal” mode (or
printing that way), the first thing you should do is check to
make sure their links haven't been broken, especially if
those graphics aren't stored within your publication. Select
“Links..."” from the File menu, and in the “Links” dialog box
find the name of your graphic. If the link is not up to date
or PageMaker cannot locate the graphic’s external file, it will
display a special symbol next to that item in the list (see the

Q&APageMaker

window's title bar (Windows), or by clicking on the resize
box in the upper-right corner of your publication win-
dow (Macintosh). :

D If you like using the “Normal” setting but want your
graphics to display at slightly higher resolution, you can
increase the “Maximum size of internal graphic” setting
and reimport your graphics.

Q Sometimes when | place a graphic, | get the mes-
sage: “The document named ‘[filename]’ was not
created with the application program ‘PageMaker.’ To
open the document, select an aiternate program with
or without translation.” What’s going on?

A You probably have the “Macintosh Easy Open” System
Extension installed, and it's interfering with PageMaker’s im-
port process. Macintosh Easy Open comes with System 7.5.
In addition, some applications such as DataVis MacLink Plus
and Aldus Fetch 1.2 automatically put the Extension in your
System when they are installed.

Macintosh Easy Open is a software Extension that allows
a document to be opened when the application that cre-
ated it is not available. Macintosh Easy Open also allows
documents to be converted into another application’s for-
mat without actually opening the document.

previous question for an explanation of those

symbols) and you'll need to reestablish or up-
date that link.

If your links are up to date and your bitmap
graphics still look chunky on screen (but print
fine), you have several options:

) If you want all your graphics to display at
high resolution, use the “High resolution”
graphic-display option.

micro tip

By holding down the Control + Shift
keys (Windows) or the Control key

(Macintosh) whileredrawing your page,

you can view graphics in high re-

solution when “Normal” is selected in

the “Preferences” dialog box.

D If the “Normal” setting works for you most of
the time, but you want your graphics to dis-
play in high resolution occasionally, you can
force them to do so using a special keyboard
shortcut—just hold down the Control + Shift
keys (Windows) or the Control key (Mac-
intosh) while redrawing your page. You can

redraw your page by selecting an option

187 pages of legal briefs have

just arrived at the office.
y  On your desk.
Apparently, your boss
wants you to key them
to his new client
¥ report. By 5:00 pm.
¥ _  [or a moment, you
W wonder if life in
prison without

arole would be so
bad after all. What now?

from the View submenu of the Layout menu,
by double-clicking on your publication
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Creating nonprinting notes

Ever wish you could create a nonprinting note or
comment in PageMaker? While there isn't a spe-
cific feature for this, you can create this effect in
other ways. Here are two methods.

First, if your publication will be printed in a
single color or your final output will be to color
separations, create a special spot color for your
notes. (Call it something like “nonprint notes.”)
Then, when you're ready to print your publication,
select “Separations”in the “Color” print dialog box

@ Separations

Print __Ink
v Process Magenta
v Process Yellow

v Process Black
nonprint notes

and select only the colors you do want to print. If
a service bureau will be creating final output for
you, make sure you let them know you've done
this—otherwise, they might print separations for
your notes, or worse, convert your notes color to

PageMaker PC/Mac

a process color and print them that way.

If that method isn't practical—for instance, if
you'll be printing final output or critical proofs to a
composite color device—try this instead. Create a
special style for your notes and assign it to any text
you don't want to print during final output or cer-
tain proofs. Then, when you want to print every-
thing in your document except

> el
SNOTE: Ny
§ Rememberto |}
\ convert RGB 1

\ TIFF to CMYK!,'
Y — Ly

the notes, edit your style so |

Monkey

that the color of the text be-
comes “Paper.” Just make sure  Business
none of the text is placed over Dethe e

colored backgrounds. Also, be
sure to use a font that will be
resident in your final output
and proofing device, or that
you're using elsewhere on the
same page—that will ensure
PageMaker doesnt end up
downloading a font for your
paper-colored text.

You can create

a special spot
color and use it
for nonprinting
notes to yourself
or to colleagues.
Just be sure not to
print that color
when you create
separations.

WINDOWS [t e ety

Unconditional 30-Day

*FINALLY, A COLLECTION OF ADDITIONS FOR

PAGEMAKER USERS —

B

sy wich 1 o taob

Pageliign™ quickly Siges and distribetes objects witheat wisy s o7 rers.
PageColors™ finds and changes the calors of lnes, ovaks, rectangles and tast.
PageGaides™ instantly adek, deletes, or dupiates object puides and ool puides.
Pagellover™ meves objects 15 mwster 384 other pages withost leaving your o,
PagePreview™ displays the first five pages of publications in the Open dilog bex.
PagePrinter™ previews pages aad astematially prints recently edited pages.

DEVSTIOYIMISAR P more! 10 Additions for the Price of Oue!

PageThumd = previews 1ad novigetes pubications withew! lesving yow corvest pape.
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Unfortunately, Macintosh Easy Open sometimes inter-
feres with PageMaker’s import process. If you see this error
message while importing, open the Macintosh Easy Open
Setup Control Panel (called just Macintosh Easy Open in Sys-
tem 7.5) and either turn off the utility or deselect the “Al-
ways show choices” and “Include choices from servers” op-
tions (these options are called “Always show dialog box”
and “Include applications on servers” in System 7.5).

Q I've noticed that you can use either SuperATM,
PANOSE, or both to work with missing fonts. Is there
a way to determine which is best for me?

A Yes. Anytime you're missing a font, the best thing todo is
install the font—that’s the only way to ensure that your
fonts look the same, retain the same line endings and page
breaks, and print the way you intended them to. Sometimes,
however, reinstalling a missing font isn't possible or practi-
cal. In these cases, use SuperATM to generate a substitute if
your font is just missing temporarily. If you need to find a
permanent substitution for a missing font, use PANOSE.
Here's why.

SuperATM is a special version of Adobe Type Manager
that can automatically create a simulated version of a miss-
ing font. When it detects a font is missing, it generates a
substitute by taking a multiple-master typeface and shap-

Q&APageMaker

ues as your missing fonts, PANOSE substitutions will often
cause line endings and page breaks to change.

PANOSE is most useful when you are missing a font that
you will not be able to install before you produce final out-
put. It’s also valuable when you want to be notified when-
ever you have a missing font—just make sure the “Show

Go, stranger, and to Lacedemon tell “"z;""'m""':
. publication containing
That here, obeying her behests, we fell. |, ;. soconone
(Bodoni) hine without Bodoni
installed, SuperATM
generated a substitute
Go, stranger, and to Lacedeemon tell with the same metrics,
That here, obeying her behests, we fell. while PANOSE allowed
& \ s us to select a similar-
(SuperATM-generated simulation of Bodoni) lowking Aisaliad font

(Times), which does not
have the same metrics

Go, stranger, and to Lacedzmon tell B

That here, obeying her behests, we fell.

(PANOSE substitute—Times)

mapping results” option in the “Font matching” dialog box
is selected so the “PANOSE font matching results” dialog
box appears whenever PageMaker detects a missing font.

For more information on using SuperATM and PANOSE in
PageMaker 5.0, see FaxYl document number 215405,
“TechNote: Using font mapping in Aldus PageMaker.” FaxY!
is at (206) 628-5737.)

ing it according to the missing font's metrics

(the exact character-spacing values), which
must be available in the “ATM Font Database”
file in your System Folder.

Using SuperATM-generated substitute fonts
works extremely well when you need to use a
different Macintosh temporarily to work on your
publication or when you're temporarily missing
a font or fonts. That's because SuperATM’s sub-
stitute fonts reproduce the exact character-
spacing values of your missing fonts, allowing
you to retain line endings and page breaks. If
you frequently move your publication around
the office or proof-print from more than one
Macintosh, then SuperATM is probably the best
font-matching system for you. Just remember
that SuperATM-generated fonts are supposed to
be temporary substitutes—they won't look ex-
actly like your original fonts, so you shouldn't

Get OmniPage OCR software now.

It’s easy to install and use. Its fast.
And it enables you to scan
in new information with no
retyping, It’s simply the
b&sfttvt . I”?‘CO . OmniPage famil
software. e

for oume]fyai an authorized Caer}(,e

tion

use them for final output.

If you would like PageMaker to use Super-
ATM, you must make sure it has been installed
successfully and that the “Substitute for missing
fonts” option is selected in its Control Panel.

Unlike SuperATM, PANOSE does not generate
substitutes for your missing fonts. Instead, it
finds or lets you specify the next-best match
among your installed fonts. Because PANOSE
substitutions are other fonts that may not have
the same (or even similar) character-spacing val-

dealer today. Or call 800-535-SCAN.

OmniPage from Caere. The recognized
leader in OCR software.
Cd

Om“iPAGE 4

Caere. the Caere logo and (OmniPage are registered trademarks of Caere Corporation. © 1994 Caere Corporation
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Michael Kieran

presents

Desktop
Color
in the
Office

A One-Day Seminar

$249

k3

1995 Schedule

Atlanta- Feb.
Baltimore IELR
Boston jan.
Chicago Feb.
Cleveland fan.
Dallas Feb.
Denver Feb.
Detroit jan.
Houston Feb.
Kansas City Feb.
Los Angeles Feb.
Miami Feb.
Minneapolis Feb.
New York jan.
Philadelphia Jan.
Pittsburgh jan.
San Francisco Feb.
San Jose Feb.
Seattle Feb.
St. Louis jan.
Washington jJan.

To register
or for further info,

telephone
1-800-269-5742

or fax
1-416-480-0192

Desktop Publishing Associates
125 Chiswick Road, Suite 513
Boston, MA 02135
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